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Trademarks

Microsoft is a U.S. registered trademark of Microsoft
Corporation.

Windows, Windows Vista, Windows 7, Windows 8, and Windows
10 are either registered trademarks or trademarks of Microsoft
Corporation in the United States and/or other countries.

Energy Star® is a registered trademark of the U.S. government.

IBM, IBM PC are registered trademarks of International Business
Machines Corp.

Other brands and product names herein are trademarks or
registered trademarks of their respective holders.

Copyright

All rights reserved. No part of this publication may be
reproduced, transmitted, transcribed, stored in a retrieval
system, or translated into any language or computer language,
in any form or by any means, electronic, mechanical, magnetic,
optical, chemical, manual, or otherwise, without the prior
written permission of Avision Inc.

Material scanned by this product may be protected by
governmental laws and other regulations, such as copyright
laws, the customer is solely responsible for complying with all
such laws and regulations.

Warranty

The information contained in t his docu ment is su bject t o
change without notice.

Avision makes no warranty of any ki nd with regard to this
material, including, but not limited to, the implied warranties
of fitness for a particular purpose.
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Avision shall not be liable f or errors contained herein or for
incidental or consequential damages i n connection with the
furnishing, performance, or use of this material.

FCC Radio Frequency Interference Statement

This product has been tested and found to comply with the
limits for a class B digital devi ce, pursuant to Part 15 of
the FCC rul es. Operation is subject to the following two
conditions: (1) thi s devi ce may not cause harmful
interference, and (2) this device must accept any
interference receiv ed, in cluding in terference t hat may
cause undesired operation. The FC C Class B limits are
designed to provide reasonable protection against harmful
interference in a residen tial installation. This equipment
generates, uses, and can radi ate radio frequency energy
and, if notin stalled an d u sed in accordan ce w ith t he
instructions, may cau se h armful in terference t o radio
communications. Howe ver, there is no guarantee that
interference will not occur in a particular installation. If this
equipment does cause harmful interference to radio or
television reception, w hich can be det ermined by turning
the equipment off and on, the user is encouraged to try to
correct the interference by one or more of the following
measures:

= Reorient or relocate the receiving antenna.

»  Increase the separation between the equipment and
receiver.

= Connect the equipment into an outlet on a circuit
different from that to which the receiver is connected.

m  Consult your point of purchase or service representative
for additional suggestions.
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C€

European Union Regulatory Notice

Products bearing the CE marking comply with the following EU
Directives:

. Low Voltage Directive 2006/95/EC

. EMC Directive 2004/108/EC

. Restriction of the use of certain hazardous substances
(RoHS) Directive 2011/65/EU

CE compliance of this product is valid if powered with the
correct CE-marked AC adapter provided by Avision.

This product satisfies the Cl ass B limits of EN55022, EN55024,
safety requirements of EN 60950 and ROHS requirements of
EN50581.

*This machine is certified as Class 1 LED product.

i)

72? As an ENERGY STAR® Partner, Avision Inc. has
oI determined that this product meets the ENERGY
AERRE STAR guidelines for energy efficiency.
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Disposal of Waste Equipment by Users in Private Union
]

This symbol on the product or on its packaging indicates that
the product can not be disposed of with your other household
waste. Instead it should be sent to appropriate facilities for
recovery and recycling in an effort to protect human health and
the environment. Fore more information about where you can
drop off your waste equipment for recycling, please contact
your local city office, your household waste disposal service or
the shop where you purchased the product.

System Requirements

CPU: Intel® Core™ 2 Duo or higher

Memory: 32 bit: 1 GB
64 bit: 2 GB

Optical Drive: DVD-ROM Drive
USB Port: USB port 2.0 (compatible with USB 1.1)

Compatible Microsoft Windows XP(SP3), Windows Vista,
Operating Windows 7, Windows 8 (32 bits/64 bits),
System: Windows 10 (32 bits/64 bits)
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Product Safety Guide
Please clearly read all these instructions, and follow all instructions
and warnings before installing and using the device.

The following indications are used in this document to obviate any
chance of accident or damage to you and/or the device.

/N WARNING Indicates potentially hazardous situations, which
if instructions are not followed, could result in
death or serious injury.

/N CAUTION Indicates a potentially hazardous situation
which, if instructions are not followed, may
result in minor or moderate injury or damage to
property.

/N\ WARNING

B Use only the AC power adapter that came with your device.
Using any other AC power adapter could cause fire, electrical
shock, or injury.

B Use only the AC power cord and USB cable that came with
your device and avoid abrasions, cuts, fraying, crimping, and
kinking. Using any other AC power cord and USB cable could
cause fire, electrical shock, or injury.

| Do not place objects on top of the AC power cord, and do not
allow the AC power adapter or the AC power cord to be
stepped on or run over.

[ | Place the device and its AC power adapter near an electrical
outlet where the AC power adapter can easily be unplugged.

B If you use an extension cord with the device, make sure that
the total ampere rating of the devices plugged into the
extension cord does not exceed the cord's ampere rating.

[ | Place the device close enough to the computer so that the
interface cable can easily reach between the device and the
computer.

Vi
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| Do not place or store the device or its AC power adapter:
e Qutdoors
e Near excessive dirt or dust, water, or heat sources
e In locations subject to shocks, vibrations, high
temperature or humidity, direct sunlight, strong light
sources, or rapid changes in temperature or humidity

[ ] Do not use the device with wet hands.

[ | Never disassemble, modify, or attempt to repair the AC power
adapter, device, or device option by yourself, except as
specifically explained in the device's documentation. This
could cause fire, electrical shock, or injury.

| Do not insert objects into any opening, as they may touch
dangerous voltage points or short-out components. Beware of
electrical shock hazards.

B Unplug the device and the AC power adapter, and refer
servicing to qualified service personnel under the following
conditions:

° The AC power adapter or plug is damaged.

° Liquid has entered the device or the AC power adapter.

° Object has entered the device or the AC power adapter.

° The device or the AC power adapter has been dropped,
or the case has been damaged.

° The device or the AC power adapter does not operate
normally (i.e. appearance of smoke, strange smell, odd
noise, etc.), or exhibits a distinct change in
performance

B Unplug the device and the AC power adapter before cleaning.

vii
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/N CAUTION:

B Do not locate the device on rackety or aslope tables. Do not
locate the device on unstable surface. The device may fall
down and this may result in injury.

B Do not place heavy objects on the unit. It may cause
unbalance and the device may fall down. This may result in
injury.

B Store the AC Power cord/USB cable bundled out of the reach
of children to avoid the risk of injury.

B Keep plastic bags bundled out of the reach of children to
avoid the danger of suffocation.

B If you are not going to use the device for a long period,
unplug the AC power adapter from the electrical outlet.

viii
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1. Introduction

Congratulations on your purc hase of the color sheet-fed
image scanner. Av ision is on e of the leading companies in
the world to develop high performance sheet-fed scanners.

Before you install and operate the new scanner, please take
a few minutes to read through thi s manual. It provi des
proper instructions for y ou to unpack, install, operate and
maintain the scanner.

The following figure indicates the package contents. Please
check all the items against your checklist. If you do not
receive all t he items, please con tact your authorized local
dealer immediately.

1-1
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Scanner Main Unit

ADF (Auto Document Feeder) Paper Tray
Output Paper Tray

USB Cable

Power Adapter/Power Cord

Software CD/Quick Guide

1.
2.
3.
4,
5.
6.

Note:

1. Only use the AC adapter DA-48M24/ DA-24C24 (APD)
included in the machine. Using other AC adapters may
damage the machine and void the warranty.

2. Please unpack the packing carefully, and check the contents
against the checklist. If any items are missing or damaged,
please contact your dealer immediately.

3. To access more service supports, visit www.avision.com to
register your Avision’s product.

1-2
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2. Scanner Installation

Precautions

m  Keep the scanner out of direct sunlight. Direct
exposure to the sun or excessive heat may cause
damage to the unit.

= Do not install the scanner in a humid or dusty place.
m  Be sure to use the proper AC power source.

= Place the scanner securely on an even, flat surface.
Tilted or uneven surfaces may cause mechanical or
paper-feeding problems.

= Retain the scanner box and packing materials for
shipping purposes.

2-1
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2.1 Installing the ADF Paper Tray Unit

Attach the Paper Support to the ADF (Auto Document
Feeder) Paper Tray.

ADF Paper Paper Support
Tray

2-2
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2. Pull out the Paper Jam Clearing Button to open the front
door to the left.

Paper Jam
Clearning
Button

Front

oor
3. Insert four protrusions on the bottom of the ADF

Tray into the holes on the front of the scanner.

Protrusions

2-3
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4. Insert two protrusions in the middle of the ADF Paper
Tray into the holes on the top of the scanner.

Protrusions

Holes

2-4
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2.2 Installing the Output Paper Tray

Insert the right and left protru sion of the Output Paper Tray
into the holes on the front of the scanner.

Output Paper Tray

2-5
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2.3

Installing the Scanner Driver

NOTE:

1).

2).

To ensure your computer can identify the USB scanner,
please install scanner driver first before connecting the
scanner to your computer.

The scanner driver contains TWAIN, ISIS and WIA driver.
After the installation of scanner driver is completed, this
scanner allows you to scan via a TWAIN, ISIS, or a WIA
interface. Start your TWAIN-compliant image editing
software application to select a TWAIN or WIA user
interface or your ISIS software to select an ISIS user
interface. You may also launch Microsoft’s Scanner and
Camera Wizard to scan via a WIA user interface.

Place the supplied CD-ROM onto your CD-ROM drive.

The software installation graphic appears. If not, run
“setup.exe”.

www.avision.com

Install Scanner Driver
Install Button Manager
Install Adobe Reader
Install A¥Scan X

Yiew Manuals

2-6
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Contents on the installation graphic:

o Install Scanner Driver: To communicate with
your scanner, you need to install the scanner driver.

. Install Button Manager V2: To use the buttons
on the scanner, you need to install Button Manager
V2. To ensure Button Manager V2 works properly,
please FIRST install scanner driver before installing
Button Manager V2.

. Install Adobe Reader: To view the user’s
manuals for the scanner and Button Manager V2,
you need to use Adobe Reader to open and view the
manuals in pdf file format. If you already have
Adobe Reader installed on your computer, you may
disregard this item.

. Install AVScan X: To scan and organize your
multi-page document(s), you can install the
software application to manage them easily and
effectively.

o View Manual: Click “View Manual” to view or
print the detailed user manual for the scanner and
Button Manager V2 respectively.

3. Click Install Scanner Driver to install the scanner driver
and then click Install Button Manager V2 to install the
Button Manager V2 unto your computer.

2-7
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2.4 Installing the Scanner Driver and Connecting the
Cables

Before connecting, make sure the power switch is off.

Plug the small end of the power adaptor into the power jack of
your scanner. Insert the other end to an appropriate power
outlet.

2.5 Turning on the Power

Press the Power button on the front panel, the Power LED
will flash. When it is finished and ready to scan, the LED
indicator will stop flashing and become steadily on. To turn
off the scanner, press the Power button for about 3
seconds, the Power LED will be off.

2-8
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2.6 Connecting to Computer

1. Connect the square end of the USB cable to the USB port of
your scanner. Connect the rectangle end to the USB port of
your computer.

2. The computer should detect a new USB device and prompt
a “New Hardware Found” message.

3. Follow the on-screen instructions and click the Next button
to continue. When the certification screen appears, click
Continue Anyway to complete the installation.

4. When the Finish dialog is prompted, click the Finish
button.

2-9
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3. Completing Your First
Scan

3.1 Loading Your Paper

3.1.1 Notice on Using the ADF

Before using the ADF, please make sure that your paper meets
the following specifications:

o Document(s) can range in size from 50 x 63.5 mm (2 x
2.51in.) to 216 x 356 mm (8.5 x 14 in.).

o Document(s) can range in weight from 34 ~ 127 g/m? (9
to 34 Ib.).

o Document(s) should be square or rectangular and in good

condition (not fragile or worn).

. Document(s) should be free of curl, wrinkle, tears, wet
ink, or punch holes.

o Document(s) should be free of staples, paper clips, paper
sticky notes.

3-1
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3.1.2 Placing Your Document in the ADF Paper Tray

Fanning Your Document

Note:
To avoid occasional multi-feeds or paper jams, please fan

your documents and align the top edges before feeding them
into the scanner. The auto document feeder can hold up to

100 pages (75 g/m?, 20 Ibs) at a time.

1. Hold both ends of the documents and fan them a few
times.

2. Rotate the documents by 90 degrees and fan them in the
same manner.

3. Align the edges of the docume nts in a st ep-like pattern
(see picture below).

Step-like

[

Direction

Scanning

3-2
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Document feeding

Place your document wi th the text face down on the ADF
Paper Tray. Align the two si des of the document wi th the
slide guides. Please note that the ADF Paper Tray can hold
up to 50-page document at a time.

Your
Document
(Face Down)

Paper
Slider

3-3
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3.1.3 Scanning a Stack of Document with Various sizes
and Weights

When scanning a batch of documents with different sizes and
weights, be sure to follow these guidelines to avoid a skewed
image or a paper jam:

1. Align the documents TOP EDGE first in the sequence of
paper size from large to small.

Ad

—
i

2. If two pages are of the same size yet with different weight,
arrange these pages in the sequence of paper weight from
heavyweight to lightweight.

0279 |

(60g)
[28g) |
(659)

(38g)

3-4



User’s Manual

3. Align the edges of the documents by tapping the bottom of
the stack against the table top.

Ad

~

Ad

IS

///T,f

4. Center these pages in the document feeder and make sure
that the edges of page of the largest size slightly touch the

Paper Guide.

3-5
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3.2 Verifying Your Scanner Installation

To verify if your scanner installation is correct, Avision provides
you a useful test program called Avision Capture Tool. With
this tool, you can perform simple scans and view the captured
images. In addition, it helps you complete your scan at a rated
speed.

The following procedure describes how to verify your scanner
installation. If the installation is not correct, please review the
preceding section to check if the cable connection and scanner
driver have been successfully installed.

Before you begin, be sure the scanner is on.

1. Select Start>Programs>Avision xxx Scanner>Avision
Capture Tool. The Select Scanner Model dialog box will be
displayed.

Helret Sennmer Model

Diriver Type:
T —

Searine Mode:
|Bovision woe ~|

2. Select your driver type and scanner model and click OK.
The following Avision Capture Tool dialog box will be
displayed.

3-6
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5.

Fit Actual

= Avision Capture Tool (TWAIN) - XXX
Rl View About

@SEN}) wScm "‘_511 File Format BMP V|'C\My51:an\\mage E} D

I i
' Save File Format File Path

Setup Scan

Choose your desired file format from the File Format drop
down list box. (Default is JPEG, other choice includes TIFF,
MTIFF, PDF, MPDF, GIF, and BMP.) The supported file
formats vary depending on your scanner model.

Type your desired folder name and file name in the File
Path box. (Default is C:\Documents and Settings\User
Name\My Documents\My Scan\Image.)

Note: If you do not wish to save the scanned image,
deselect the Save button since default is Save Enable. In
this case, the thumbnail view will be disabled. And
therefore, after viewing all the scanned images, only the
last one will remain on the screen.

Eﬁ.j Se
Click the Setup button ( WJ tup) or choose Setup from the
File menu to prompt the Scanner Properties dialog box.

3-7
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10.

& Scanner Properties g]
| Image | Paper | Setting | Information

[ [Front&uto Color Detection | | Binarization

Frant Color Sensitivity:

o™

Image —
Selection
Box

ond Gray

I

1ant BEW

Fiesolution [dpik 200 |

Irvvert | Black on White ¥

I [ s |

Sean Source! | Auto Document Feeder |

From the Image Selection Box, choose your desired image
type for your scanned image. (Default is Front B&W) If
you have a duplex scanner, choose Front and Rear to scan
both sides of your document.

Click OK to quit the Scanner Properties dialog box. (To
learn more details about the Scanner Properties dialog box,
please see the subsequent chapter, Using the Scanner
Properties Dialog Box.)

Place your document face down on the document glass or
face up in the auto document feeder.

In the Scan Validation dialog box, click the Scan button

. Hean
( o ) or choose Scan from the File menu.

The document will be scanned and displayed in the Scan
Validation screen. After the scanned images have been
displayed, your scanner installation verification is
completed.

3-8
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Fe Vav About

o gon ||[Bl noe 525 [Conscamimens

whates

W ars they fort

eightor ends! ndiet, share
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10 ot In 4 Sugt-houad whaom. OF B young Weitani, u Caitormas
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eng). Tha o
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Wour shuddar. But by #0 by w5 5 #, 16 b of 3 GG
1 iy

par e
230 fanvn: PRy what § mean 16 b, 8 b dancer in Uhe maves. My

e gl

Fit Page View

Thumbnail View

11. You can view the scanned image in Fit Page (‘_@‘) or
Actual Size (100%) button (.D ) from the Viewing toolbars
at the right side.

12. Click the Close box or Quit from the File menu to exit the
Scan Validation Tool.

3-9



User’s Manual

3.3

& Scanner Properties

—frimage | Papes | Selting | Inkomation

[ [Froot fustes Cokes Dienesction
) T a—)
— 0 fumey ]
[ [From Bt

[0 [Hes Ao Cokn Detocion |
[ [Rear Colen ]
[ ooty ]
[7 [Fms b |

A Glance of the Scanner Properties Dialog Box

Bnaczshon:

s | Frestiokd v
Sensiiviy @

Revchsion tdeil an L

o0hW

Irvemil. Elach on 'Wile »

o) o]

. Tab Options

Choice: Image, Compression, Color Dropout,
Paper, Multi-Feed Detection, Preview, Options,
Settings, Information.

. Image

Selection Box

Choose your image type and the side of
document you wish to scan. Options vary
based on type of scanner.

3. Brightness Adjust the brightness level from -100 to +100.

4. Contrast Adjust the contrast level from -100 to +100.

5. Resolution Determine the quality of the scanned image.
The industry standard is 200 dpi.

6. Invert Reverse the color of your scanned image.

7. Scan Source |Choice: Auto Document Feeder, Flatbed,

Flatbed (Book), Automatic (varies due to
different scanner model)

. Defaults

Reset all values on the tabs to the factory
default settings.

3-10
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4. Using the Scanner
Properties Dialog Box

The Scanner Properties dialog box allows you to configure the
scanner’s settings. It consists of several tabbed windows each
of which will be described in this chapter.

Note: In this chapter, all options are available based on a
duplex (double-side) scanner. If you have purchased a simplex
(single-side) scanner, all options are available for single sided
only.

& Scanner Properties EJ
Image | Paper | Settng | Infarmation

Front Auto Color Detection Binarization:
Sensiiviy:

|Front BEw | o

@ M=

=

Resalution (dpi) | 200 Bl ; :]

Invert: | Black onwhite el

T [ .|

Scan Source: Muto Document Feeder hud i

Profiles ] ‘ Custom bl

The Scanner Properties dialog box

4-1
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4.1 Buttons on the Scanner Properties Dialog Box

*_. Scanner Properties

Image iF’aDer_ Setting | Information

[1 |Front Auta Color Detection Binarizatian: J|Dyriric

Tont Caolor Sensitivity:

e A |

ront Gray

Tont B

ear Auta Color Detection Fesolution (dpi} |2UD bt | E

ear Calor

Irwert: | Black onwhite v
ear Gray I

=

[ P |

2ar B/

)

Scan Source: iAuto Document Feeder

Frofies.. | | Custom ]

The buttons on the Scanner Properties dialog box

Buttons | Description

Defaults | Click the Defaults button, the factory default
settings will be shown on each tab.

Cancel Click the Cancel button to leave the Scanner
Properties dialog box.
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The following table shows the default settings :

Tab name Default settings

Image Image : Front B&W

Binarization : Dynamic Threshold
Resolution : 200 dpi

Invert : Blank on White

Scan Source : Auto Document Feeder
Threshold : None

Brightness : None

Contrast : None

Compression None

Color Dropout | None

Paper Cropping : Automatic

Deskew : Yes

Orientation : Portrait

OverScan : 0.00

Note: The availability of this option
varies due to scanner model.

Unit : Inch
Multi-Feed None
Detection
Preview None
Options Rotation Degrees : None

Blank Page Removal : None
Edge Fill : White - 0 mm
Image Control Option : None

Setting Enable Energy Saver : Enable, 15
minutes after last scan action

Show Scanning Progress : Yes
Show Warning Message : Yes
Save Settings after Closing : Yes
Imprinter Digital Imprinter

4-3
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4.2

Showing or Hiding Tabs

The [Scanner Properties] dialog box is displayed in default
with three basic tabs - Image, Paper, and Information. To
show more tabs, click the [Scanner Properties] icon to access
more scan settings.

To show more tabs,

1.

Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tab] to show available tab names.
The available tabs include Compression, Color Drop out,
Preview, Rotation, Separation, Multi-Feed, Options,
Settings, and Imprinter. (Note: the options vary based on
scanner model.)

Choose the tab you want to display. The selected tab will
be shown with a check mark and then displayed in the
[Scanner Properties] dialog box.

To access the settings, click the selected tab on the top of
the [Scanner Properties] dialog box. The page of the
selected tab will be displayed.

To hide a tab window,

1.

Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tabs] to show available tab
names.

Choose the tab you want to hide. Then, the selected tab
will be hided in the [Scanner Properties] dialog box.

Note: The [Image], [Paper], and [Information] tab can
not be hided since they preprogrammed to be displayed by
default.
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& Scanner Properties

L - .| Compression ._‘
Colar Dropont

| Preview

| A mmEI) aurra Rotation

Front Color | Beparation
[ [Front thray | v Options
v Setting
[ [Front BW | Inprinter
T T
ear Auto Color Detection
[ [Reer Avto Color Detecti
O
O

Resolution {dpi):

| Black on White

Scan Sonrce iAum Diocument Feeder

b |
[ Profles.. | [Custom s
Color Matching: !Documem "‘
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4.3 The Image Tab

The Image tab allows you to choose the front side and (or) the
rear side of your document, the type of image, and to set
several basic scan settings. Note that except for the resolution,
you can set individual scan settings for the front side and the
rear side. For example, all settings in the Image tab,
Compression tab, Color Dropout tab can be set individually for
the front and the rear side. However, the settings in the Paper
tab, the Option tab, and the Setting tab have to be set the
same for the front and rear side.

& Scanner Properties g]
Image ‘Ene_r I VSettin_g__ Infarmation |

ront Auto Color Detection Binarization:

Tant Colar Sensitivity: 20 £ | b

Dynamic Threshold

/O |

Tont Gray

Front B

=

ear Auta Color Detection Resolution (dpi} 200

2ar Color —_—
Ireert: | Black on white

ear Gray

o FTIL  [ |
7| [T [T [@ EE =
o
o
= o
@
g
g
g 5

ear B/

: :Aulu Document Feeder ~

Frofiles.. | Custorn |

The Image tab dialog box
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4.3.1 The Image Selection Box

Frort Auto Colo Detection

B0

ront Color

Fiont Gray

[ |

ront B

Fiear Auto Color Detection

=

eal Gray
ear BEW

(]
o) (T [T = =
g
o
3

oo

The Image Selection box includes the
image type and document side option. If
you wish to scan both the front si de and
the rear side of your color document, you
can check both Front Color and Rear Color
at the same ti me. Note the options vary
based on type of scanner.

Example 1 : Scanning a two-sided color document, both

sides in color

O bt G Do ]
e —
T —

0 o ko Gt
T R—
T —

Side/Image
Selection

Rear
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Example 2 : Scanning a two-sided color document, one
in B&W, the other in color

1ot Auto Color Detection
font Color

ont Gray

OoO®EO

nont BEw

ear Auto Colos Detection

ear Gray

ilim il
&

8000

ear BEW

Side/Image
Selection

Image Type

Description

Color

Choose Color if you wish to scan a color
image for your original in color.

Gray

Choose Gray image if your original contains
actual shades of gray.

B&W

Choose B&W if your original contains only
text, pencil or ink sketch.

B&W

Gray
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Front/Rear Auto Color Detection:

Click to automatically detect and scan the front or the rear
page of your color document in color image mode. If your
document is in colors, the scanner will automatically scan the
document into a color image. If your document is non-color,
you can choose the output to be either B&W or Gray from the
Non-Color Selection option. This option is useful when you
have a mixture of color and non-color document.

Note: If you choose Front Rear Auto Color Detection, you can
not specify the image mode of your rear page and vice versas.

Sensitivity of Auto Color Detection

If your documents contain primarily B&W text and small
amount of light or pale colors and you do not wish them to be
recognized as color image to save the file size, you can
increase the sensitivity value by moving the bar to the right to
let these images to be detected as B&W. The value ranges from
1 to 100. The default is 37.

Original
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4.3.2 Other Image Options

Binarization This is the process of converting a
grayscale or color image to a bi-tonal
image. There are several different
methods of performing this conversion.
Options: Dynamic Threshold, Fixed
Processing, Halftone 1—5, Error
Diffusion.

Dynamic Threshold: Selecting
Dynamic Threshold allows the scanner
to dynamically evaluate each document
to determine the optimal threshold value
to produce the highest quality image.
This is used to scan mixed document
containing faint text, shaded background,
or color background with a single setting.
If Dynamic Threshold is selected,
Threshold, Brightness, and Contrast are
not available.

Sensitivity of Dynamic Threshold
Occasionally your scanned image may
contain small dots or speckles. To remove
these spots, increase the sensitivity value
by moving the bar to the right. The value
ranges from 1 to 30. The default is 20.
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Fixed Processing: Used for black-and-
white and other high contrast documents. A
single level is set to determine the black-
and-white transition. The threshold is
programmable over the entire density
range. Fixed Processing sets Contrast to
0. If Fixed Processing is selected,
Contrast is not available.

Halftone: In addition to the black and
white display, Halftone can present a
somehow gray shade of image by using
different size of dots. Halftone image looks
like the picture we have seen in the
newspaper. Options include Halftone 1,
Halftone 2, Halftone 3, Halftone 4,
Halftone 5.

Error Diffusion: Error Diffusion is a type
of Halftone. Error Diffusion gives good
image texture and makes text in images
more readable than Halftone.

BROTMOUS

Halftone Imége
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F. Michelang
Architecture
this huge vol
seulpture, pai
photographs,
ceding with a
illus, (120 in ¢
10 3/4" x 14°

G. NEW Botti
Renaissance

unprecedents
first lifesize m
— ENCIMOUS ne

Error Diffusion Image
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Threshold

Used to convert a grayscale image to a
bi-tonal image. The value ranges from 0 to
255. A low threshold value produces a
lighter image, and can be used to subdue
backgrounds and subtle, unneeded
information. A high threshold value produces
a darker image, and can be used to help pick
up faint images.

Adjust the threshold setting by dragging the
Threshold sliding bar to the left or right to
achieve the desired threshold setting.

T 3 @

200 dpi, 200 dpi,
Threshold:50, Threshold:100,
Brightness: O Brightness: O
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Gray

Document Type: Choice: Normal, Photo, Document
Three options of document type are provided when you choose
Gray as the image type for your scanned document. Choice:
Normal, Photo, Document.

o Document: Choose Document if your original contains
pure text or a mixture of text and graphic since it is an
optimal setting for regular business document. When
using Document, only Threshold can be adjusted.

) Photo: Choose Photo if your original contains photo to
reproduce your photo in vivid grayscale image. When
using Photo, no Threshold and Contrast can be adjusted.

. Normal: When using Normal, Threshold, Brightness, and
Contrast can be adjusted.

Threshold: The value ranges from 0 to 255. The default is
230. A low threshold value produces a lighter image, and can
be used to subdue backgrounds and subtle, unneeded
information. A high threshold value produces a darker image,
and can be used to help pick up faint images. Adjust the
threshold setting by dragging the Threshold sliding bar to the
left or right to achieve the desired threshold setting.
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Normal Photo Documeht
(Threshold: 230)

0. Pe

Normal Photo Document
(Threshold: 230)
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Brightness Adjusts the lightness or darkness of an
image. The higher the value, the brighter
the image. Drag the slider to the right or
left to increase or decrease the brightness.
The range is from -100 to +100.

Contrast Adjusts the range between the darkest and
the lightest shades in the image. The
higher the contrast, the bigger the different
grayscale. Drag the slider to the right or
left to increase or decrease the contrast.
The range is from -100 to +100.

BRERAAIIRASRRAZEARREALENAREERINRTIL,

=

Brightness: -50 Brightness: O Brightness: +50
(Normal)

...........

Contrast: -50 Contrast: O Contrast: +50
(Normal)
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Resolution A good control of the resolution results a
good detail of an image that scans. The
resolution is measured by dots per inch
(dpi). Normally, the greater the dpi number,
the higher the resolution and the image file
size. Be aware that greater resolution takes
more time to scan, and more disk space for
the scanning image. For your information,
an A4 size color image scanned at 300 dpi at
True Color mode consumes approximately 25
MB of disk space. A higher resolution
(usually means over 600 dpi) is only
recommended when you need to scan a
small area at True Color mode.

Choose a resolution value from the drop
down list. The default value is 200 dpi.
Available resolutions are 75, 100, 150,
200,300, 400 and 600. Or you may choose
your desired value by clicking the box in the
right side of the drop down list and press the
arrow key to select your desired value and
then click the Add button to include it in the
drop down list. Note: The resolution is up to
300 dpi if an imprinter or a MICR reader is
installed or connected to the scanner.

— : T
Resolution: 75 dpi Resolution: 150 dpi
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Invert

Reverses the brightness and the colors in the
image. The default setting is Black on a White
background. Reverse mode is White on a Black
background. For color images, each pixel will be
changed into its complementary color at the
command of Invert.

“I am not worthy to have you ¢nter my

: that is God, I beg all my brothers - those w
& who work manually, clerics and ay brothars
ards belng humble in all things; not to glorify
rto become interlorly proud because of good w
sametimes says or does in them or through tl
ard:  “Do not rejoice-- in the Fact that the de
110:20} Let us be firmly convinced of the fact

Black on White

“I am not worthy to have you enter m!

that is God, I beg all my brothers - those v
E who work manually, clerics and lay brothe

rds being humble in all things,; not to glorify
to becorne Interlorly proud because of good
sometimes says or does in them or through
rd: “Do not rejoice-- in the fact that the dd
10:20) Let us be firmly convinced of the fa

White on Black
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Scan
Source

Choice:

Auto Document Feeder: Used to scan
multiple pages.

Flatbed: Used to scan a single page. For
example, pages from newspaper clipping,
paper with wrinkles or curls.

Flatbed (book): Used to scan several
inside pages from book.

Automatic: Allow the scanner automatically
set its scan source. If Automatic is selected
and there is documenti n both the auto
document feeder (ADF) and the flatbed, then
the scan source will be au tomatically set to
ADF. If Automatic is selected and there is
document on ly in f latbed, then the scan
source will be set to flatbed.

Merge Two Sides into One Image:

If you have a sheet-fed duplex scanner with
front input tray, you can scan an A3 size
document with an innovative method. Thus,
fold your A3 size document into A4, and then
load the paper in the front tray. Choose
Merge Two Sides from the Scan Source
option and then the scanner is able to scan
both sides of your document and merge two
A4 images into one A3 image.

When you select Merge Two Sides into One
Image, the Cropping or Multi-feed function
will be disabled.

Note: This feature must be used with a
carrier sheet. Regarding how to load a
document with a Carrier Sheet, refer to
Section 4.6.2, Other Paper Selection.

Note the options vary based on type of
scanner.
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Note: If you have purchased a duplex sheet-
fed scanner, choose [Merge Two Sides] on the
[Scan Source], then the scanner is able to scan
both sides of your document and merge them
into a single image.

Select the “"Merge Vertically” option to merge
the front side and the rear side of a page into
one image vertically. If the “"Merge Vertically”
option has not been selected, the front side and
the rear side of a page will be merged into one
page horizontally.

Front
Side :
...................... Front { Rear
Side | Side
Rear :
Side
Merge Vertically Merge Horizontally

Note the options vary based on type of
scanner.
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Color
Matching

The purpose of Color Matching is getting the
accurate color. This option uses the default
parameters (ICC profile) to adjust the colors
of the image.

Choice: None, Document, Photo

e None: C hoose “None” to disable this
option.

e Document: Choose “Document” if your
original contains pure text or a mixture of
text and graphic since it is an optimal
setting for regular business document.

e Photo: Choose "“Photo” if y our origin al
contains photo to reproduce your photo
in vivid color image.

\

After Color Matching
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4.3.3 Scanning color images
The following options are available for scanning color images.

. Brightness

. Contrast
. Resolution
. Invert

4.3.4 Scanning grayscale images

The following options are available for scanning gray images.

Brightness
. Contrast

Resolution
. Invert

4.3.5 Scanning B&W images

The following options are available for scanning B&W images.

. Binarization (Dynamic Threshold)
. Resolution
. Invert
Or
. Binarization (Fix Processing)
. Threshold
. Brightness
. Resolution
. Invert
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4.3.6 Editing Profiles

The Scanner Properties dialog box allows you to change and
save your frequently used scan settings into a profile. You can
edit these profiles by renaming or deleting them.

To add a new profile,

1.

Customize your settings. (For example, change your
resolution, image type, cropping method, scan size, or
other scan settings.)

Click the Image tab and then choose “Profiles” to prompt
the “Edit Your Profile” dialog box.

[T

Crent

Click “"Add” to enter the name of the profile and then
choose “Save”.

Add A New Profile

Please enter the name of the profile:

I Save ][ Cancel ]

The new profile will be saved and shown in the “Profiles”
dropdown list box.
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To load a profile,

1.

2.

From the Image tab dialog box, choose your favorable
profile from the “Profiles” dropdown list box.

Edit Your Profile

Profile: Duples, B, 200 dpi v Add J [ peete |
Dupl 1 dpi
Duplex, Color, 200 dpi
Duples. Gray, 200 dpi
Simplex, BEEW, 200 dpi

[ Rename. l [ Reset ]

Simplex, Color, 200 dpi
Simplex, Gray, 200 dpi

Your favorable profile will be immediately loaded and
displayed on Scanner Properties dialog box.

To delete a profile,

1.

From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.

Edit Your Profile

Profils:

Rename Reset

Choose the profile you want to delete from the dropdown
list box.

Click “Delete”. A Confirm message “Are you sure you want
to delete this profile?” is prompted.

Choose “Yes” to delete or “Cancel” to quit.
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To rename a profile,
1. From the Image tab dialog box, click “Profiles” to prompt
the Edit Your Profile dialog box.
Edit Your Profile =13

Profile:

e
implex - B&W, 200dpi
I00dpi

2. Choose the profile you want to rename from the dropdown
list box and then click the Rename button.

3. Enter new name for the profile.
Eename a Profile B]

Please enter the new name of the profile:

Original Nome: {Betsy

Wewr Name: |

Cancel J

4. Choose "Save” to save the new profile or “Cancel” to quit.

Note:

The preset default profiles include Flatbed, Simplex-B&W, 200
dpi, Simplex-Gray, 200 dpi, Simplex-Color, 200 dpi, Duplex-
B&W, 200 dpi, Duplex-Gray, 200 dpi, Duplex-Color, 200 dpi. If
you have a simplex or a sheetfed scanner, the duplex or the
flatbed option will not be available.
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4.4 The Compression Tab

The Compression tab allows you to compress your scanned
image and choose the level of compression. Bi-tonal images
are normally compressed using CCITT standard called Group 4
(G4). Color and grayscale images are often compressed using
JPEG technology. Move the JPEG Quality slider to the right or
left to increase or decrease the level of compression. Note the
greater the compression level, the lower image quality. Default
is 50%.

Note that the compression depends on your image editing
application. If your image editing application does not support
the type of compression format, then either a warning
message will appear or the image quality of the compressed file
will not be acceptable.

JPEG (Joint Photographic Editor Group). This group developed
and lent their name to a file compression standard for color and
grayscale images that is widely used by scanners, and software
applications. On Microsoft Windows-based systems, a file with
the extension .jpg has normally been compressed using this
standard.

For scanning color or gray images, the following compressions
are available:

. None

. JPEG

For scanning B&W images, the following compressions are
available:

. None

. G4
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& Scanner Properties El

| Image | Compression | Paper || Setting | Infarmation |

Front Auto Color Detection Compressior:

1 ot b reion|
e —
S —
e —

The Compression tab dialog box
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4.5 The Color Dropout Tab

4.5.1 Color Dropout Selection

The [Color Dropout] tab allows you to select either green,
red, blue, or a color of your choice to remove the details of the
selected color from a scanned image. This feature is used to
sharpen your text when using OCR (Optical Character
Recognition) software. Note this feature applies only to the
gray or black and white image.

Choice: None, Auto, Remove Red, Remove Green,
Remove Blue, Custom

- None: Does not remove any color.

- Auto: Automatically outputs the image with the details of
the primary color removed.

- Remove Red/Remove Green/Remove Blue: Outputs

the image with the details of the specified color removed.

Custom: Specify the color you wish to remove by entering

its RGB (Red, Green, and Blue) value respectively.

Advanced Options:
Quality Mode: Range: 0~20. Default: 10
When [Quality Mode] is selected, you can determine the
color to be dropped out using the [Filter Threshold] slider. A
lower value will drop more of the selected color out, while a
higher value will leave more of the selected color in.

- Normal Mode: Use an optimized setting to determine the
color.
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ar_30 dﬂy&j&fﬁe‘( . SIGHT AT _30 dayg after SIGHT |

(FIRST OF THE SAME TEN@R Al DATE | (FIRST OF THE SAME TEN@R AND\DATE 1

’\I nehu Infernatio stnchu dnfernatio
g v | THESUM OF THE SUM OF

Original Auto/Remove Green
(normal mode)

THE SUM OF THE SUM OF

at 3o dayc after  sioar a1 _30 dayg after SIGHT
(FIRST OF THE SAME TENOR AND DATE (FIRST OF THE SAME TEK@R AND\DATE
Hsinchu Internatio nchu, rnatio

Remove Red (normal mOde) Remove Green (qua“ty
mode: Threshold: 18)

Preview the color dropout result:

To preview the color dropout result, please follow these steps:

1. Click the [Scanner Properties] icon () on the upper
left corner, and choose [Tab] to show available tab
names.

2. Choose [Preview] to show the Preview tab.
Click the [Preview] tab to show the Preview page.

4. Load your document to the scanner and click the
[Preview] button to get a preview image.

5. On the [Image] tab, click [Gray] or [Black and White]
image mode and then choose [Custom] on the [Color
Dropout] tab. A [Preview window] button will be
displayed.

6. Click the [Preview window] button to prompt the
[Preview] window with the previewed image.
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Move your cursor over the preview image. Your mouse
cursor now becomes an Eyedropper.

Click to select a color which you wish to remove.

Click and hold your mouse button to view the result
after removing the specified color. If the result is
satisfactory, click [OK] to close the Preview window.

- ) - [Cremmrea ] o
740110078 o Cwed- | R OL8: 114007 e
The Preview Window The Color dropout result
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£ Scanner Properties

!_Iﬂa£| Color Dropout | Paper | Preview | Enhancement | Setting | Information |

Front Auta Calor Detection Color Dropaut:

BonkE ol Advanced Processing

[ [Front B&w

|

[] |Rear Gray
[ |Rear Baw

]

The Color Dropout dialog box
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To select a color on the Color palette,

1. Click the Color
Dropout tab from
the Scanner
Properties dialog
box.

2. Choose Gray or
B&W from the
Image Selection
box and click
“Custom” from
the Color Dropout
drop-down menu.
The Color palette
appears.

& Scannar Properties
s

Coder Diopont.

: Idmrl Elg |
T ]

[ FesGray
[ [emBitw |

& Seanper Properties 4]
Image | Coke Dropout | Paper | Seting | Infomation

Coor Droummnd.

[ [FeuGear 1
Bl a— .

[ Delos ] e

J [ e ]
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4,

Move your cursor
over the palette.
The cursor
becomes a cross
sign.

Click t o ch oose a color.

simultaneously.

& Seanner Properties (3]
enagn | Cokes Diropons P | Sty | Indomaten
Cobon Droment
1 [Fioes Gy Telersnce 10 € 3
——

(2] T
Fied -
frowes 10|
Bl &

i TT- T L
7 [Res Bl .

o (e |

T he RGB values are changed
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4.6 The Paper Tab

The Paper tab allows you to define values relating to image

output (i.e., Auto Crop or not, Scan Area, OverScan, Multi-Feed
Detection).

& Scanner Properties E]
| Image: | Eo_\o.r-a;npoul-} Paper i‘l"—"reviéw.::ns.él-t\né || Information |
Cropping
&) Portrait Landsea
T 0 : 1 i1
Adjustment Left 000 s Top: 0. UUE e
i T oo Bottom: |
Right: | 0.00) % afton \ 000 3
Background Setting Ew’hlte Background w |
Uni: ! Inches ~ |
Feeding
Transpoit Timeout; < | ¥ | 0OS5econds
Diefallts [ 0K ] [ Cancel

The Paper tab dialog box
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4.6.1 Cropping

Cropping allows you to capture a portion of the document
being scanned. Choice: Automatic, Automatic (36),
Fixed to Transport, EOP (End of Page) Detection,
Automatic Multiple, Relative to Documents.

Options Description

Automatic Automatic adjusts the cropping window
according to different document sizes and
automatically straighten a skewed
document. Use this option for batches of
mixed-sized documents.

Automatic Automatically adjusts the cropping window
(36”) according to different document sizes
smaller than 36” and automatically
straighten a skewed image. Use this option
for batches of mixed-sized document.

Note: The availability of this feature
varies due to scanner model.

Fixed to This feature allows you to define the area
Transport or zone to be imaged. Use for batches of
same-sized documents. If you select this
option, you can use the arrow keys to
define the x and y offset values, width and
length to redefine your scanned area. The
Display window will show image placement
as you change the values.

EOP (End of | This feature allows you to define the area
Page) or zone to be imaged. Use for batches of
Detection same-width but different length
documents. If you select this option, you
can use the arrow keys to define the x and
y offset values, width and length to
redefine your scanned area. The Display
window will show image placement as you
change the values.
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Automatic This option allows you to place various
Multiple sized documents such as photos, ID Cards,
or business cards on the flatbed (if
available) and lets you create multiple
individually cropped images in one scan.
Note: To correctly create multiple images,
please make sure there is at least 12mm
(0.5") of space between each document.
Relative to This option allows you to crop different
Document areas on your documents and deliver these
images in B&W, Gray, or Color separately.
For example, there are applications which
require you to store the entire document in
B&W and a part of the document in color to
save storage space. This is useful for
documents where a photograph or
sighature appears in a consistent area on
the document such as resumes, and so on.

The following options are only available when Fixed to
Transport is selected.

. X-Offset — the distance from the left end of the
scanner to the left edge of the scanning area.

Y-Offset — the position from the top end of the
document to the top end of the scanning area.

. Width — the width of the scanning area.
. Length — the length of the scanning area.

. Center: automatically calculates the x-offset for center-
fed feeding based upon document size selected.
|

— — relocate the scan area by click the arrow key on
the cross sign while retain the scan size. View the result
from the Display window.
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Relative to Document: (used for batches of same-sized
documents)

This option allows you to crop different areas on your
documents and deliver these images in B&W, Gray, or Color
separately. For example, there are applications which require
you to store the entire document in B&W and a part of the
document in color to save storage space. This is useful for
documents where a photograph or signature appears in a
consistent area on the document such as resumes, and so on.

The following procedure describes how to reproduce the entire
document in B&W and a portion of document (picture) in color.

1. On the Paper tab, choose “Relative to Document” or “Fixed
to Transport” from the Cropping option.

2. Choose your scan size from the Scan Area option. The
selected scan size will be displayed in a red rectangular
box. This is also the scan size of your entire document.
(For example, ISO B5. If you have not chosen a scan area
and leave the selection as Noneg, then the default area will
be the scanner’s maximum.)

& Scanner Proparties =

imege | Pager | P

T 3 4 5 8 t W oW

M - o

— Ared
rectangular
~ THISE box

|

Mt (5]

-Oifsat e
it mm

Lergih i

une CE—

] Simtectid arma sgpbes b all s

Doty Pevew | [ ok | [ Concel
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3. Click the Preview tab to display the Preview window. A
black rectangular box appears to indicate the max. scan
size your have just selected.

& Scanner Proparties

The Image —
Selection
Box
A black
: rectangular
e | box

4. Click the Preview button to view the entire image in low
resolution to correctly crop your relative scan area.

The Preview
Image

The Preview
Button

5. Select image type from the Image Selection box. The
selected image will appear in highlighted color. (For
example, Front Color)

6. Place your cursor on the Preview window and click your
left mouse button. A cross sign will appear as illustrated.
Create your relative scan size diagonally by dragging the
left mouse button to your preferable size. The selected
area will appear in a red box as illustrated.
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A Cross b
Sign
The
Relative
Area

Check the B&W image from the Image Selection box to
scan the entire document.

Click the Scan button to start scanning the document in
two image types and sizes. (See the result in below.)

The entire document in B&W The relative area in color
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4.6.2 Other Paper Selection

Carrier Sheet Mode:

Check this option to automatically crop the scan window
according to your document size when scanning non-standard
document (fragile, irregular-size document) with a carrier sheet
(optional). Note: The availability of this option varies due to
scanner model.

Loading Documents Using a Carrier Sheet

A Carrier Sheet is a plastic sheet specifically used for loading
non-standard document onto the scanner. It allows you to scan
document that can not be scanned in the regular way. Also,
documents larger than A4 size, such as A3 and B4, can be
scanned by folding in half, inserting into the Carrier Sheet, and
scanning in duplex mode. You can also scan documents that
can be damaged quite easily such as photographs, or irregular
size documents that are difficult to load directly such as

clippings.
To scan document using a Carrier Sheet,

For documents larger than A4/Letter size, such as A3

a. Fold the sheet to be scanned in half.
b. Fold the sheet tightly and smooth out crease. Otherwise,
the sheet may be skewed during scanning.

JI

LU

I

I

]

1

= I
=
I

|

I

I

!

I

1. Open the Carrier Sheet and place the document
inside.
Align the top of the document to the top of the Carrier
Sheet (the printed area).
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For documents larger than A4/letter size, such as
A3

Align the top of the document to the top of the Carrier
Sheet (the printed section) and the folded portion to the
right edge of the Carrier Sheet so that the document fits
into the Carrier Sheet at the upper corner.

For non-standard document
Center your document in the Carrier Sheet.

Load the Carrier Sheet with the gray section (printed
section) facing downwards.

Adjust the paper guides to the width of the Carrier Sheet.
Adjust the paper guides so that there is no space
between the guides and the Carrier sheet. Space between
the guides and Carrier Sheet may cause the Carrier Sheet
to become unaligned during scanning, and skew the
scanned image.

Start the scan.
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Notice:

e [Carrier Sheet] is available for the models that support the
Carrier Sheet.

e Some functions are disabled when [Carrier Sheet] is
checked.

e This option may not work properly on some applications.

Scan Area

Choose your desired paper size with the drop-down list box. Or
you may select a custom paper size by clicking the Scan Area
box and then click Add to include in the choice.

Choices are listed below:

None
US Letter- 8.57x 11~

US Legal — 8.5” x 14~
ISO A4 — 21 x 29.7 cm
ISO A5 —-—14.8 x 21 cm
ISO A6 — 10.5 x 14.8cm
ISO A7 — 7.4 x 10/5 cm
ISOB5 —-17.6 x 25 cm
ISOB6 —12.5x 17.6 cm
ISOB7 —8.8 x12.5cm
JISB5 —18.2 x 25.7 cm
JISB6 —-12.8 x18.2cm
JISB7 —9.1 x12.8cm
Scanner Maximum
Long Page (<118™)
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Long Page (<118”):

When you need to scan documents whose length exceeds
scanner maximum, please choose Long Page. Note if Long
Page is selected, the Multi-Feed Detection will not be
available. (Note: This option and the maximum allowable
document length vary due to type of scanner.)

When Long Page (<118”) is selected, be sure to specify your
document size in the Length and Width field.

Notice when scanning long page document:

1. Pull out the extension in the ADF Paper Tray.

2. Secure enough space around the Output Tray to prevent
the ejected paper from falling off the Output Tray.

3. To ensure the performance, in color mode, set the
resolution to be 300 dpi or lower; in Black and White
mode, set the resolution to be 600 dpi or lower.

4. Depending on your system environments, application, or

your specified paper size, there may be insufficient
memory to perform scanning.

OverScan

Overscan allows you to add a specific margin at top and bottom
or right and left (Options vary based on the type of scanner) of
the edge of the image. This is used to reduce possible corner
clipping on the skewed images and often applied to a batch of
skewed document to be scanned in the auto document feeder.
Select a value ranging from 0 to +5 mm for Top/Bottom and 0
to 2.8 mm for Left/Right. Note the overscan result will not be
shown in the Display window and that the availability of the
function and selectable range vary based on type of scanner.
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Adjustment

When “Automatic” is selected in the [Cropping] option, the
OverScan option will be replaced by the Adjustment option.
With the Adjustment option, you can specify the scanned
image to be slightly extended or cut from the edge of original
document if a positive or negative number has been specified.

Top/Bottom/Left/Right: Specify the range to be slightly
extended or cut from the top/bottom/left/right edge of
document. Available range: from -1 inch to +1 inch.

<+ (range): -1”" ~ +1 "

: original document

Pre-Feed

Choice: Enable, Disable. If enable is selected, you can set the
amount of time the scanner starts pre-feeding your paper after
your documents has been loaded into the feeder. The default is
disable. Note: The availability of this option varies due to
scanner model.
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Transport Timeout

Set the amount of time the scanner will wait and then start
auto scan after the first scan job is completed. If you have
many separate documents need to be scanned at the same
scan settings, this feature is especially useful. The default is 0.
The value ranges from 0 to 30 seconds.

Note:

1 Within the specified timeout period, if you load your
document to the feeder, the scanner starts scanning
automatically.

2 If your scanner has a flatbed option and you place your
paper on the flatbed, after the timeout period, you need
to click the Scan button on the TWAIN user interface to
start scanning.
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Background
Setting

This option allows you to set your scan
background. Choice: White Background,
Black Background.

Note: For a sheet-fed scanner with an auto
document feeder, this option is currently
available only in the “Auto crop” mode. For a
scanner with a flatbed platen, this option is
available either in the “Auto crop” or the
“Fixed to Transport” mode.

3 N
White Background

B
Black Background
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4.7 The Multi-Feed Detection Tab

Multi-Feed Detection

Multi-Feed Detection allows you to detect overlapped document
that go through the auto document feeder. Multi-Feed usually
occurs due to stapled documents, adhesives on documents, or
electro-statically charged document. Note : The availability of
the function varies based on type of scanner.

& Scanner Properties EJ

| Image | Paper | Muli:Faed Detestion | Seting | Information

Multi-Feed Detection
[ &dditional Length Detection |

] Ultrasoric Detection

Unit: I Inches

3

T T [ o )
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Additional Length Detection

Additional Length Detection allows you to define the length of
document being multi-fed. This value indicates the additional
length exceeding your scan area. The Display window will
show the size of the document as you change the value. A
value of 0 indicates no additional length detection. The
Additional Length Detection is best used when scanning same-
size documents in the auto document feeder.

Ultrasonic Detection

Ultrasonic Detection allows you to set overlapped document by
detecting paper thickness between documents. Note: The
availability of the function varies based on type of scanner.

There are two options available if Multi-Feed is detected.

e Stop Scanning after Multi-Feed

If this is selected, the scanner will stop the feeder and
display the following Warning dialog box if multi-feed is
detected.

{ | E Multifeed iz detected, please remove the rest paper from ADF.
L

Action:

1. Follow the instruction on the Warning dialog box to
remove the rest pages on the feeder.

2. Click OK to close the Warning dialog box.
3. Scan the rest pages.
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Clear the Multi-Fed Paper: Auto

If this is checked, once multi-feed is detected and scanning
operation is stopped, the scanner will automatically clear the
transport of the multi-fed paper. If this is not checked, once
multi-feed is detected and scanning operation is stopped, you
need to manually clear the transport of the multi-fed paper.
Note: The availability of this option varies based on type of
scanner.

e Multi-Feed Alarm

If a wave file is added, the scanner will make a sound
alarm if multi-feed is detected yet no Warning dialog box
will be displayed.

If "Stop Scanning after Multi-Feed” is selected, the scanner
will stop the feeder.

If "Stop Scanning after Multi-Feed” has not been selected,
the scanner will continue to scan till the end of your
document.

Action:

1. If “Stop Scanning after Multi-Feed” is selected, follow
the action described in the preceding section “Stop
Scanning after Multi-Feed” on the previous page to
complete your job.

2. If “Stop Scanning after Multi-Feed” has not been
selected, rescan the pages where multi-feed is
detected.
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How to add the sound alarm:

1. Click the Browse button on the right side of the speaker
icon. The Open dialog box appears.

2. Choose your wave file.
3. Click the Open button. The wave file is added.

Units

Defines the primary measurement system. Inches,
Millimeters, and Pixels are available.
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4.8 The Preview Tab

The Preview tab allows you to preview (a low-resolution scan)
your image before final scan. This preview image lets you
allocate your scan area. You can choose your scan area by the
“Scan Area” drop down list box or placing your cursor on the
Display window and dragging it diagonally on the Display
window. Then, a red rectangle box will appear to indicate the
selected area.

Note: If you choose “Automatic Cropping” on the “Paper Tab”,
then to select a scan area on the Preview tab is not allowed.

& Scanner Properties

| Image | Color Dropest | Paper | Preview | Enhancement | Setting | Information

7] |Front Auto Color Detection (]
- Ll

5] |[Froct Colx

I

] |Front Gray

| [Fromt Baiw
ean Auto Colot Detection
ea Colof

II

The Display
Window

eal Gray
! [Fea BB

e 0 ] e B

Scan drea

HeDffzat on
v Offset 0.00

Width 826

43 4r 4 0

Lengthe 11.63
Urik: Inches -

[ Selectad area apphe: 1o sl modes

|

The Preview Tab
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4.9 The Enhancement Tab

The Enhancement tab allows you to set following additional

image processing settings.

b_. Scanner Properties

Image | Color Dmpou‘té -F'apel _.Previaw Enhancement I.Setting-.: Infarmation |

Funch Hole Removal

[ Punch Hole Removal

Background Setting

Background Procesting:

Nore v

Edge Fill

@ white [JEdge Extend

O Black | U‘ Millmeters
[iespeckle

[

Ok

] [ Cancel ]

The Option tab dialog box
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Punch
Hole
Removal

You can remove punch holes from the output
scanned image when scanning punched document.
Note the availability of this feature varies
depending on your scanner model.

Original Output image

Punch holes can not be removed when:

Resolution is set lower than 150dpi

The hole is near the edge of the document

The holes are not aligned along the edge of the
document

Punch Hole Removal is available only when
“Auto Crop” is enabled. If either “Fixed to
Transport”, "EOP (End of Page) Detection”,
“Automatic Multiple”, “"Relative to Documents” is
selected from the Cropping option on the Paper
tab, the Punch Hole Removal option will be
disabled.
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Background Processing: The [Background Processing]

option allows you to smooth background color or remove it to

make image clearer. The option is especially useful for

documents with color forms such as invoices.

Choices: None (default), Smooth, Removal

- None - no background processing will be performed
(default)

- Smooth - produces images with a more uniform
background color. This option improves image quality.

- Removal - identifies the background color and then
removes it.

Sensitivity: Choice: 0, 1, 2, 3, 4. Default: O
- The higher the value, the more background color will be
kept.

Mode: Auto, Moiré

If [Smooth] is selected in the [Background Processing]

option, then the choices for the [Mode] option includes Auto,

and Moiré.

- Auto - uses the factory preprogrammed mode to proceed
background smoothing.

- Moiré — Remove the moiré patterns that appear on the
background of the image when scanning printed material.

If [Removal] is selected in the [Background Processing]

option, then the [Mode] option will be replaced with [Fill

Color]. Choices: White, Auto.

- White - identifies the background color and substitutes it
with white.

- Auto - identifies the background color and substitutes it
with the color of the largest background zone.
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Background Processing:
Removal
Fill Color: White

Note: Background color in small zone will not be processed or

removed.
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Edge Check White or Black if you wish to add white or
Fill black edge on the border of your scanned image.
Enter the value from 0 to 5 mm. Default value is 0.

Original Edge Fill: 5mm (Black)
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Despeckle

Occasionally small dots or specks appear in the background of
a scanned image. Remove unwanted speckles provides a
cleaner image for OCR (Optical Character Recognition)
processing, and also helps to reduce compressed file size.

Define the speckles (also known as image noise) you wish to
remove by specifying its number (size) and radius (range). The
measuring unit is pixel. The higher the number, the more
speckles will be removed.

%plague on thee! Hast thou
never an eye in thy head? Canst
net hear? .
—The First Pari of King Henry the Fourth:
2.1.26-27

A carrier 1o Gadshill, the host of 2 tavern.

Before Despeckle
(noise number:0, noise radius:1)

L‘%plague on thee! Hast thon
never an eye in thy head? Canst
not hear!
—The First Part of King Menry the Fourti:
11.26-27

A carrier 1o Gadshlll the host of a tavern.

After Despeckle
(noise number:22, noise radius:10)

Note:

. The function is currently available for Black and White
image only.

o To scan at rated speed, it is recommended to set the
noise radius up to 10 pixels.
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4.10 The Rotation Tab

The Rotation tab allows you to set the following image rotating
options:

& Scanner Pro perties [gl

| iﬁaga ':.I-:'a_per-i Rutatinn ‘Set-tlng i;‘f‘o‘rma‘ti‘oni

Rotation

Rotation Degrees :

Image Control Options

Split Image: !Elone el

Flip Side Rotation

Image Control Options

[ Mirror

T
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Rotate
Image

Choose the rotation angle from the drop down
list if you wish to rotate your scanned image.

Choice: None, 90°CW(clockwise),
90°CCW/(counter clockwise), 180°, Auto
based on contents. Auto rotate every
even page.

123 —

(\®
(S
Original Rotate 90°CW
< €T1
—
Rotate 90°CCW Rotate 180°

Auto based on contents: When Auto
based on contents is selected, images can
be rotated to their proper orientations based
on their contents.

Auto rotate every even page:
Automatically rotate 180° on every even
page. This is especially useful when you scan
the inside pages from a book. As a result, if
you choose “Flatbed (book)” from the “Scan
Source” option, “auto rotate every even page”
will be selected as default.

Note: This option varies based on type of
scanner.
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Split
Image

By splitting an image, two separate images are
created horizontally or vertically. This is useful
for documents containing two pages per image
when you want to save them as two images
(one page for one image). Choice: None,
Horizontal, Vertical. Default is None.

Horizontal: Divide one image into the upper
half and the lower half.

Vertical: Divide one image into the left half and
the right half.

‘B Bm
[da]
Split Horizontally Split Vertical
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Flip Side Select “fanfold” to rotate the image of the
Rotation reverse side to 180 degrees.

This is applied to double-sided document
which are viewed in portrait are sometime
fed into the scanner in landscape or vice
versa.

Choice: Book, Fanfold.

If “"Book” is selected, the image of the
reverse side will not be rotated.

The following illustration shows the documents which should
be viewed in portrait are fed into the scanner in landscape

= WO T

-
B, S
=
RETED « SRR DY —REORRE

« BTN IR TR E 012y RN - JEE

oLzAw
BRRMIEE

— e
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Image  Check the Mirror box if you wish to reverse the right
Control and left side of your image.
Option

e

Original

L

The Mirror Effect
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4.11 The Separation Tab

The Separation tab allows you to enable the detection engine to
detect the blank page, barcode, and patch code and then notify
the software application which supports document separation to
separate your multi-page documents. Choices: Blank Page
Removal, Barcode Detection, Patch Code Detection.

& Scanner Properties gJ

| Image | F'_épe_l Il F‘EDt‘a‘tion: Separation '_S.e.ttir.w__g Il Informalién:

Blank Page Removal

[[] Blark Page Removal Threshold:

Barcode Detection

[ Enable

Fatch code Detection

[]Enable

|

Blank Page Check if you wish to remove the blank page
Removal and move the slider to the left or right to your
desired threshold.

When the bar code has been detected successfully - a file
[avbarcode.ini] will be created and stored in the following path:
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Windows XP: C:\Documents and Settings\All Users\Application
Data\%PRODUCTNAME%

Vista, Windows 7, Windows 8, Windows 10:
C:\ProgramData\%PRODUCTNAME%

Barcode Detection:

Check [Enable] to detect barcode and notify the software
application for advanced processing. Please note the whole
document will be checked and no specific detection area needs
to be designated.

Click the [Select Barcode Types] button to select the barcode
types you wish to detect.

Barcode Types:
The following barcode types can be detected.

Two-dimensional codes
e Aztec

e DataMatrix

e PDF417

e QR Code

One-dimensional barcodes:
Add-2

Add-5

Airline 2 of 5

Australian Post 4-State Code
BCD Matrix

Codabar

Code 128 (A,B,C)

Code 2 of 5

Code 32

Code 39

Code 39 Extended

Code 93

Code 93 Extended
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e Datalogic 2 of 5

e EAN 128 (GS1, UCC)
e FEAN-13

e FEAN-8

e GS1 DataBar

e Industrial 2 of 5

e Intelligent Mail (One Code)
e Interleaved 2 of 5

e Inverted 2 of 5

e ITF-14 / SCC-14

e Matrix 2 of 5

e Patch Codes

o PostNet

e Royal Mail (RM4SCC)
e UCC 128

e UPC-A

e UPC-E

Note:

) Recommended resolution: 200~600 dpi for regular
barcode, 300~600 dpi for QR code

) Skewed barcodes may not be recognized correctly.

° Using the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the sheets.
If the sheet is not recognized correctly or gets smudged,
replace it with a new sheet.

Patch code Detection:
Check [Enable] to detect patch codes and notify the software
application for advanced processing.

A patch code is a pattern of parallel, alternating black bars and
spaces (i.e. a barcode) that is printed on a document. Patch
code sheet is most commonly used as a document separator in
a stack of document.

You can find various sizes of patch codes (PDF) by choosing
[Start] menu>[All Programs]>[Avision Scanner
Series]>[Patch code] in succession.
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Simply print the PDF file to produce the patch code sheet.
Insert the patch code sheets to wherever you want the file to
separate.

Patch code sheet

Notes to print the patch codes:

Use blank white paper.

Set the scaling to 100%. The sheet is not recognized
correctly when printed in a size smaller than the original.

Do not use toner saving mode. The sheet is not recognized
correctly when the print is too light.

Do not use thin paper in order to avoid bleed-through from
the back.

When you copy a patch code sheet that you printed out,
make sure to copy by the same size and brightness as the
original copy.

Use the same sheet repeatedly may decrease the
recognition accuracy due to accumulated dirt on the sheets.
If the sheet is not recognized correctly or gets smudged,
replace it with a new sheet.
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4.12 The Setting Tab

The Setting tab allows you to set the following settings:

& Scanner Properties El
Image: | Cokor Dropout | Feper | Previess | Enhencemens 3200 Infommation|
Cache
Mok | Mmmery Size -
Meimciy Sz < ¥ Defauk
Energy Saving Canirel
Enakla Eneigy Saver < * 15 minutes:
BUa]  [FEnsie Fows OF < ¥ 240 minules
[=] Show Scenring Frogress b
- Corpresson
. "
[ S hiow Waming M eszage BiColor Ciopouk
Muk-Feed Delecton
W Prevey
Retaion
Senardian
W Erharcemert
Tl mprinter
[ oekun | [ ok [ o

The Setting tab dialog box

Energy Saving
Control

Check the Enable Energy Saver box
and move the slider to set the amount
of time to start the energy saver after
your last action. The range is from 1 to
242 minutes. The default value is 15
minutes.

Enable Power
Off

Check the Enable Power Off box and
move the slider to set the amount of
time to automatically turn off the
scanner after your last action. The
range is from 1 to 480 minutes. The
default is 242 minutes (4 hours). Note
the value of “Power Off” has to be
greater than or equal to the value of
“Energy Saving”.
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Cache Mode: None, Page Number, Memory
Size.

This option allows you to assign a specified
memory size from the available RAM to
process the image data. By specifying a
smaller memory size, you can free more
memory for other applications you are
running. By specifying a larger memory
size, you can have more memory to
process the image data especially when you
have a large amount of documents needed
to be scanned.

You can also specify your memory size by
the page number. For your information, an
A4 color document scanning at 300 dpi
consumes approximates 24MB.

Image Count

When the selected cache mode is “none”,
the image count option allows you to assign
number of pages you need to scan. For
example, if you wish to scan the first two
pages, simply move the page slider to 2,
and the scan action will be stopped when
the scanning of the first two pages have
been completed.
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Show Scanning
Progress

Check and the scanning progress bar
will be shown during scanning.

Show Warning
Message

Check to show the warning messages
such as “"ADF pad count exceeds
50,000 scans (the number varies based
on type of scanner). Please replace the
ADF pad and reset the pad count.”

Save Settings
after Closing

Check to save your scanner properties
settings after leaving the dialog box.
Next time when you open the Scanner
Properties dialog box, the previously
saved settings will be shown.

4-70



User’s Manual

4.13 The Imprinter Tab

The Imprinter tab allows you to print alphanumeric characters,
date, time, document count and custom message on your
scanned image if digital imprinter is selected or at the back of
your document if external imprinter is selected.

& Scanner Properties g]
| Image | Color Dropout | Paper | Preview ‘_ Enhancement || Setting| Imprinter | Infarmation |

Digital Imprinter

Cartent

Pint Al

Custom:

Counter [noan :L] Date/ Time: [Nuna - ﬂ

Custom Font: "N ormal v

Advanced Pririt Position

Font Attributes: iNormaI | Position: MIdE"E v\

Sting Orientation: Marmal 7| o, I I

Sample

Dot

Choice: External Imprinter, Digital Imprinter. If you have
installed an external imprinter, choose external imprinter. If
you do not have an imprinter, choose digital imprinter. Note
External Imprinter provides a vertical and rear-side print
capability while digital printer provides a horizontal and front-
side print capability.
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Contents

Print All Check Print All to automatically print the
text at all pages of your documents.
Uncheck Print All to print the text for the
first page of your documents only.

Custom Enter your custom text to be included in your
print string.

Counter Show the document count for the scan
session. This value is increased sequentially
by the scanner.

Date/Time | Choose if you wish to include the date and
time in your print string.

Format: YYYYMMDDHHSS For example,
20090402170645-check0001 indicates year,
month, date, hour, seconds, your custom
text and the counter.

Custom Choose your desired font.

Font Choice: Normal, Fixed Width
Fixed Width (Mono spaced) fonts have a
fixed character spacing. So each character
occupies the same width.

Advanced
Font Choose your font attributes. Choice:
Attributes Normal, Underline, Double, and Bold.
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String Choose your string orientation.
Orientation | Choice: Normal, Rotated, Vertical,
Vertical Inversion, 90 degrees CW, 90
degrees CCW

2qeQlLoc
2010abc

Normal Rotated

OoDTLWOoO—=0M
cNoOoO—Omlo

Vertical Vertical Inversion

2qeQ 10¢
2010abc

90 degrees CW

90 degrees CCW

If you check the digital imprinter to stamp
text on your scanned image, the illustration of
normal and rotated string is shown below:

2010abc 9qE0l0C

Rotated

Normal
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Print Choose the position you wish to print your
Position string. Move the slider to the right to increase
the value or to the left to decrease the value.
Range: 0~355mm, default:0 mm

The value indicates the height from the
bottom of your paper to the last letter of your
string. This option is available only if an
external imprinter is installed.

0TO0¢ 29eT000

| The value of
Print Position

|

Print Position (for digital imprinter)

Choose the position of your printed string. Choice: Top,
Middle, Bottom, Custom. If Custom is selected, enter the X
and Y offset value to specify the position.
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4.14 The Information Tab

The Information tab displays the following system and scanner

information.

& Scanner Properties

CPL:

RAM:

0s:

05 Language:
Disk Diive:

Free Disk. Space:

Application Name,
TwAIN Driver Yersion:
100 Driver Version:
Port Type:

ID / Address:

Optical Resolution:

Scanner Model

Serial Mumber:
F/w/ Wersion:

Image || Color Diopout | Paper | Preview | Enhancement | Setting | Imprinter | Information

Intel[R] CorefTh) i3-2120 CPU & 3.30GHz
1023 MB
Microsoft Windows XP Service Pack 3 [Build 2600]
English [United States]
Fived drive C:\Total 204650BFree:14113ME
Fied drive 'r\Total 102338MEBFree:81 22MB
14119 ME

Avision Caplure Tool 1.6(1.9]
6.00.062014

0,9, 204,528

use

Lse

500 dpi

AD280
VAR

5

Cancel

The Information tab dialog box

The “Report” button :

If you encounter any error message while using the scanner,
click the Report button. A report.txt file [Windows XP:

C:\Documents and Settings\All Users\Application

Data\%PRODUCTNAME%; Vista, Windows 7, Windows 8,
Windows 10: C:\ProgramData\%PRODUCTNAME®% (C: system
drive)] will be generated. Please send this file to the nearest
service center for trouble shooting.
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The “Reset Roller Count” button :

After scanning over a recommended number of pages (refer to
subsequent section 7.4 Replacing the ADF Roller) through the
ADF, the ADF roller may be worn out and you may experience
problems with document feeding. In this case, it is highly
recommended to replace the ADF roller with a new one. (Note
the replacement of the ADF roller has to be performed only by
authorized service center. Therefore, please return your
scanner for roller replacement.) After replacing the ADF roller,
click the "Reset Roller Count” button to reset the roller count.

Note :

The lifetime and the replacing procedure vary based on type of
scanner.
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5. ISIS Interface Operation

* Please refer to the preceding chapter, Scanner Installation, to
install ISIS scanner driver. You may start your ISIS-compliant
software application to scan via the ISIS user interface.

The ISIS driver operation method is similar to the TWAIN's.
Every function on the ISIS interface screen is briefly described
as below:

Scanner Sethings

HMode: Brightness
| Black and Wwihite =] | & Manual € Aulatic

Dither: B = s Default
Halftore 4 - Cancel

Bk petirch: Drarken I Horm I Lighten I e

|300 B gless

Page Size: LContrast

|45 -14.8%21.0cm ~| | # Manual € Alitaat

FIXDFLT Wersion 55.1.260.851 S TR R = -

Avwizion PN Driver V2,01 062402 I

Mode: Select one of scan modes, including B&W, gray, color
options.

Dither: 5 halftone levels available, can be disabled.

Dots per inch: Select your desired resolution.

Paper Size: Select your desired paper size.

Brightness: Adjust your scan image brightness or darkness.

Contrast: Adjust the range between the darkest and the
lightest shades in the image.

Default: Click to reset all settings.

Area: Select your desired scan area or position.
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6. Using the Buttons

The following picture shows the 3 buttons and 1 function
screen on the scanner.

Function Cancel/Stop  Scan

® ¢ O O

i -~ The Scan button

The Cancel/Stop button

Function-display
screen

Function selector
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6.1 Installing Button Manager V2

Button Manager V2 provides you an easy way to scan your
document and then link the scanned image to your designated
software application. All this can be done by a simple touch of
the button on the scanner. Yet, before you scan, it is
recommended to check the button configurations first to ensure
a proper file format and a destination application.

6.2 Checking the Button Configurations before Scanning

1. Button Manager V2 runs from the system tray. After Button
Manager V2 and the scanner driver are properly installed,
Button Manager V2 is started and the Button icon will be
displayed on the system tray at the bottom right corner of
your computer screen.

€)% 0l4lpM

2. Left-click the Button Manager V2 icon to prompt the
following Button Panel.

E This indicates the scanner model

n J—_,i{ iScan {Image) W

o
H |—_,¢‘|' iScan (OCR)

1‘5 —  The Function

Scan To App Icon
! (The number of

E;‘ B function icons

= vary based on
H {@ Printer L type of

scanner.)
= =]
The Button S =L@ BRI

Icon

The Button Panel
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3. The Button Panel shows the first five scanning buttons.
Right-click the button (function) you wish to check. The
Button Properties window appears.

Name of the Selected Button

| Basic | unas Adiustment | Color Dropout | Imeee Processine | More Setings |
Button
Hean Parameters
Name )
Resolution(dpi) J | 300
Trnage Mode = i

Image Mode [m ) Auto Paper Size: !Amu Crop & Deshew _:!
Selection [ OCo: O Duple Basic Scan
Box [ @Gy Parameters

I:l ©) Blsck and White Advanced Settings:  []Tse TWAIN
Folder and HiE iy
file name Directory: | C:ADocuments snd Settingsvoid My Documentsy chtu.'r\e5§ [ Browss ]
for the Fils Name: |Image_##### | [ More... ]
scanned _ =
. File Format: | OCE(For iScan Cily) v I
Image

Destination: | & iBean vl
scan To Description: | licati and i the d 1 ditable
destination o | S o L o el s e
and settings

OCR Language: | Chinsse Traditionsl JJI Sean Count; 0
OCR OCR Zane: Keyword: |70 i 1
settings =

o, of Recognized Charscters After Kesynwiond | ‘

If you wish to change the setting, use this window to reset

the setting for the file format, destination application, or

other scan settings.

4. Click the OK button to leave the window.
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6.3 Scanning From One Touch of the Buttons

1.

pw

Adjust the paper guide for the width of paper and load the
document with their tops into the automatic document
feeder.

Check the number on LCD screen on the scanner to ensure
if you are selecting the proper scan settings and destination
application. (For example, if you wish to scan with button
#4 “Custom” which opens Microsoft Paint and displays the
scanned image in the window of Microsoft Paint, the LCD
screen should show #4).

Press the Scan button on the scanner.

After the scanning is finished, the Microsoft Paint software
will be launched and the scanned image appears in the
main window of Microsoft Paint as below.

[o momrangmnEnnan
Fra BEEE E BEE

Note:

1.

2.

For details information on how to use the Button Manager
V2, please refer to the user’s manual in the supplied CD.
You may also use Button Manager V2 on your desktop by
starting Button Manager V2 from All Programs or double
clicking the Avision Scanner Utility from the Control Panel.
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7. Maintenance

7.1 Cleaning the ADF

From time to time the ADF pad and feeding rollers may
become contaminated with ink, toner particles or paper dust.
In this case the scanner may not feed documents smoothly.
If this occurs please follow the cleaning procedures to return
your machine to its original state.

The Cleaning Procedures

Soak a cotton swab with some isopropyl alcohol. (95%).

2. Press the Paper Jam Clearing button. Open the front door
to the left. Wipe the upper feeding roller by moving the
swab from side to side. Rotate the roller forward with
your finger and repeat the cleaning steps above until the
entire roller is cleaned.

3. Wipe the pad in one direction from top to bottom or the
other way around. Be careful not to damage the pick
springs.

4. Close the scanner front door. Your scanner is now ready
for use.
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i @ Paper Jam
Release

Button

ADF Pad

Feeding
Roller

Front
Door
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7.2 Cleaning the Glass

1. Press the Paper Jam Clearing button. Open the front door
to the left.

2. Wet a cotton swab with some isopropyl alcohol. (95%)

3. Wipe the glass and the white area as illustrated in below
by moving the swab from side to side to rid the dust or
dirt.

Glass

ADF Front Door
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7.3 Replacing the ADF Snap-in Pad

After scanning approximately 50,000 pages through the ADF,
the pad may be worn out and you may experience problems
with document feeding. In this case, it is highly recommended
to replace the pad module with a new one. For ordering the
pad module, please consult your nearest dealer and follow the
procedure below to replace it.

Disassembling Procedure

1. Press the Paper jam clearing button on the upper-left
corner.

2. Gently open the ADF Front cover to the left.

3. Press both arms of the ADF snap-in pad module inwardly
with your fingers to pull out the ADF snap-in pad module.

Assembling Procedure

1. Take out the ADF pad module from the box.

2. Press both arms of the ADF snap-in pad module inwardly
with your two fingers.

3. Place it into the holes until it snaps into place.
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7.4 Replacing the ADF Roller

After scanning approximately 200,000 pages through the ADF,
the ADF roller may be worn out and you may experience
problems with document feeding. In this case, you may need
to replace a new ADF roller. For ordering the ADF roller, please
consult your nearest dealer and follow the procedure below to
replace it.

The Disassembling Procedure

1. Move the tab of the ADF Roller UP as indicated.

The Tab

Move the
Tab UP
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2. Hold and press the roller in the arrow direction as
indicated to remove the roller.

ADF Roller

Note:
To install a new ADF roller, please follow the reverse order of
the disassembling procedure.
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8. Troubleshooting

8.1 Clearing a Paper Jam

In the event of a paper jam, follow the procedures below to
remove the paper:

1. Press the ADF Release Button on the right side. Gently
open the Scanner Front Door to the left.

2. Carefully pull the paper out of the ADF unit.

3. Close the scanner front door. Your Scanner is now ready
to use.
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8.2 Questions and Answers

Question:

Answer:

Question:

Answer:

Question:

Answer:

Paper becomes jammed during
scanning.

1) Open the front door.
2) Pull out the jammed paper carefully.
3) Close the front door.

More than one sheet of paper are
fed into the scanner.

1) Open the scanner front door.

2) Remove the multi-fed sheets.

3) Close the front door.

4) Flatten the corners and edges.
Loosen the paper before putting it
into the paper guide again.

5) Check the feeding roller condition.
If necessary, follow the cleaning
directions in section 7.1 and
perform the cleaning.

Paper becomes skewed in the
scanner.

1) Use the slide guide to keep the
paper path straight.

2) Check the condition of the feeding
roller. If necessary, follow the
cleaning directions in Section 7.1
and perform the cleaning.
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Question:

Answer:

Question:

Answer:

Why does my scanned image
always come out too dark?

1) Please adjust the screen settings to
SRGB.

2) Please adjust the brightness
settings on the screen from
application software.

When | choose optical resolution
to be 600 dpi, the "auto crop' and
"deskew" functions will be
disabled.

Since to perform auto crop and deskew
consumes great deal of system
memory, it is suggested if you wish to
perform "auto crop" and "deskew"
functions, please choose your optical
resolution to be smaller than 600 dpi
to prevent a error message.
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8.3 Technical Service

Before contacting Avision, please prepare the following
information by referring to Section 4.14, The Information Tab:

m  Scanner serial & revision number (located on the bottom of
the scanner);

= Hardware configuration (e.g., your host CPU type, RAM size,
free disk space, display card, interface card);
The name and version of your scanning software application;
The version of your scanner driver.

Please call us at:

Headquarter

Avision Inc.

No. 20, Creation Road I, Science-Based Industrial Park,
Hsinchu 300, Taiwan, ROC

TEL: +886 (3) 578-2388

FAX: +886 (3) 577-7017

E-MAIL: service@avision.com.tw

Web Site: http://www.avision.com.tw

US and Canada Area

Avision Labs, Inc.

6815 Mowry Ave., Newark CA 94560, USA
TEL: +1 (510) 739-2369

FAX: +1 (510) 739-6060

E-MAIL: support@avision-labs.com

Web Site: http://www.avision.com
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China Area

Hongcai Technology Limited

7A,N0.1010, Kaixuan Road, Shanghai 200052 P.R.C.
TEL :+86-21-62816680

FAX :+86-21-62818856

E-MAIL :sales@avision.net.cn

Web Site:http://www.avision.com.cn

Europe Area

Avision Europe GmbH

Bischofstr. 101 D-47809 Krefeld Germany
TEL: +49-2151-56981-40

FAX: +49-2151-56981-42

E-MAIL: info@avision-europe.com

Web Site: http://www.avision.de

Espaco Brasil

Avision Brasil Ltda.

Avenida Jabaquara, 2958 - Cj. 75 - Mirandodpolis
Sao Paulo / SP

TEL: +55-11-2737-6062

E-MAIL: suporte@avision.com.br

Web Site: http://www.avision.com.br
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9. Specifications

All specifications are subject to change without notice. For the
most up-to-date and detailed specifications, please refer to our
web site at http://www.avision.com

Model Number :

Light Source:

Optical Resolution:
Scanning Modes:
ADF Capacity:
Document Size:

Max. Document Size:
Min. Document Size:
Paper Weight:
Interface:

Power Source:

FL-1402B (Duplex Scanner)
FL-1410B (Simplex Scanner)

LED

600 dpi

Black & White/Grayscale/Color

Up to 50 pages (75 g/m?) (20 Ib.)
Letter, legal, A4, B5, A5, business card
216 x 356 mm (8.5 x 14 in.) (ADF)
50 x 63.5 mm (2 x 2.5 in.) (ADF)
34 ~ 127 g/m? (9 ~ 34 Ib.)
Hi-speed USB 2.0

24V, 1.0A

Operating Temperature: 10°C ~ 35°C

Dimensions:
Min. (WxDxH)

Max.

Weight:

308 x 172 x 271 mm
(12.1 x 6.8 x 10.7 in.)

308 x 446 x 329 mm
(12.1 x 17.6 x 13 in.)
2.6 kg (5.73 Ib.)
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INndex

A

Additional Length Detection, 4-
49

Auto Color Detection
sensitivity, 4-9

B

B&W, 4-8
Background Setting, 4-47
Binarization
Dynamic Threshold, Fixed
Processing, 4-11
Blank Page Removal, 4-64
Brightness, 4-17
Button Panel, 6-2
Button Properties window, 6-3

C

Cache
None, Page Number, Memory
Size, 4-69
Color, 4-8
Color Dropout
Remove Red, Remove Green,
Remove Blue, Custom, 4-
29
Color Matching, 4-22
Contrast, 4-17
Cropping
Automatic, Fix to Transport,
EOP Detection, 4-36
Custom Font
Normal, Fixed Width, 4-72

D

default settings, 4-3
Despeckle, 4-58
Noise Number, Noise Radius,
4-58
Document Type
Normal, Photo, Document, 4-
15
Dynamic Threshold
sensitivity, 4-11

E

Edge Fill, 4-57
Enable Power Off 4-68
Energy Saving, 4-68

F

Fixed Width, 4-72
Flip Side Rotation, 4-62
Font Attributes
Normal, Underline, Double,
Bold, 4-72

G

G4,4-27
Gray, 4-8,4-15

I

Invert,4-19
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J
JPEG, 4-27
M
Mirror, 4-63
Multi-Feed Detection, 4-48
O
OverScan, 4-44
P
Print All, 4-72

Print Position, 4-74
Punch Hole Removal, 4-54

R

Reset Roller Count, 4-76
Resolution, 4-18

Rotate Image, 4-60

S

Scan Area, 4-43
Split Image
None, Horizontal, Vertical, 4-61
String Orientation
Normal, Rotated, Vertical,
Vertical Inversion, 90 deg
CW, 90 deg CCW, 4-73

T

Transport Timeout, 4-46

U

Ultrasonic Detection, 4-49
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